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INTRODUCTION
Capture videos and photos of all your adventures with the Kidizoom® 
Action Cam HD. Built with you in mind, the Action Cam HD can go 
anywhere you do with two included mounts so you can attach it to a bike, 
skateboard and more. It also comes with a waterproof case and floating 
handle so you can record videos and photos up to 6' underwater. Out of 
the water, the interchangeable wide angle lens will help make sure you 
capture the whole scene! This sturdy camera has a color screen and 
can take regular videos and photos in addition to stop-motion videos, 
time-lapse photos and more. You can also explore your creativity with 
fun effects, frames, photo filters and special video effects! The Action 
Cam includes learning games for even more fun.

DISCLAIMER:
Adult supervision is recommended when the camera is being used by a 
child during activities involving bikes, skateboards or any other sports.
We do not advise performing any stunts or tricks or any other dangerous 
activities when using the camera.
When using the camera on a bike, skateboard, or any other vehicle, 
obey all rules of the road, signals and signs, and stay away from traffic 
and groups of people. 
Place the camera in a position where your child will not be tempted to 
play with it while riding. Using the Kidizoom® Action Cam HD during 
physical play and movement is at the user’s own risk.
VTech® claims no responsibility for any misuse or failure to follow these 
guidelines.

INCLUDED IN THIS PACKAGE
• Kidizoom® Action Cam HD  

(with built-in Li-ion polymer battery*)
• Waterproof Case

• Camera Holder

• Wide Angle Lens

• Floating Handle

• Bike Mount

• Mounting Attachment

• Micro-USB Cable

• Wrist Strap

• Parent’s Guide

*Battery is not replaceable.

• Adhesive Flat Mount
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Adhesive Flat MountMounting AttachmentBike Mount

Kidizoom® Action  
Cam HD 

Waterproof Case Camera Holder

Micro-USB Cable

Floating Handle

Wrist Strap*Wide Angle Lens

*Remove Wrist Strap from Action Cam before placing in Waterproof 
Case to avoid water leakage.

Note: The metallic coating on the Kidizoom® Action Cam HD is 
insulating.
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WARNING:
All packing materials, such as tape, plastic sheets, packaging locks and 
tags are not part of this toy, and should be discarded for your child’s 
safety.
ATTENTION : 
Pour la sécurité de votre enfant, débarrassez-vous de tous les produits 
d’emballage tels que rubans adhésifs, feuilles de plastique, attaches, 
étiquettes et vis d’emballage. Ils ne font pas partie du jouet.
The battery in this product must not be disposed of with household 
waste. This battery is recyclable. Please follow your local recycling 
regulations.
NOTE: Please keep this parent’s guide as it contains important 
information.
NOTE : Il est conseillé de conserver ce guide des parents car il comporte 
des informations importantes.
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Master Power Switch
When the switch is set to the Off position , the camera is disconnected 
from the battery and the battery will not charge. Move the switch to the  
On position  to connect the camera to the battery and allow it to be 
recharged.
Note: When the camera is in daily use, you may leave the switch in the 
On position. It is only necessary to turn the Master Power Switch to Off 
when the camera isn’t in use for an extended period of time.
Camera Button 
Press this button to switch to Camera mode and also to control the 
shutter and take a picture.
Video Button 
Press to switch to Video mode and to start or stop recording.
Home (On/Off) Button 
Press to turn the camera On. Press and hold for two seconds to turn 
it Off.
While the camera is On, press this button to go to the Home menu or to 
go back to the previous menu.
OK Button 
Press this button to confirm a choice or action, or as a control button in 
certain games.
Tip: The OK button can also be used to take photos in Photo mode.
Left and Right Buttons  
Use these buttons to select options, or as control buttons in certain 
games.
Memory Card Slot 
Insert a microSD card here for memory expansion. 
Micro-USB Port 
Connect to a computer with the included micro-USB cable to transfer 
files to a computer and to charge the camera. 
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PRODUCT SPECIFICATION
Display 1.8" color LCD
Language Multilingual (US English, UK English, Deutsch,

Español, Français, Nederlands)
Photo Resolution 1280 X 720 (HD) - Does not support photo effects

640 X 480 (SD)

Video Resolution 1280 X 720 (HD) - Does not support video  
  effects and only available  
  when using a memory card 

320 X 240 (240p) 
160 X 120 (120p) 

Video Length 
Limit per File

30 minutes
As limited by the maximum size per file (2 GB). 
Maximum length of HD videos may not reach 30 
minutes due to memory limitations. Estimated 
maximum length of HD videos is around 5 
minutes.*

Focus Range 1.5 feet - ∞
Internal Memory 128 MB built-in memory (shared with program 

data, actual memory available for user storage 
will be less)

Memory Card 
Format and 
Capacity

microSD / microSDHC card (not included) with 
capacity from 1 GB to 32 GB Class 10 or above 
are recommended

File Format Photos: Standard Baseline JPEG
Video: AVI (Motion JPEG)

Connectivity Micro-USB 2.0 cable (included) for connecting to 
a computer

Battery Rechargeable Li-ion Polymer battery (battery is 
not replaceable)
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Optimal 
Operating 
and Charging 
Temperature

32°F to 104°F (0°C to 40°C)

Important Note:
The camera itself is not waterproof. Ensure it is properly inserted into 
the included waterproof case and that the strap has been removed for 
underwater use. Read the details and instructions about the waterproof 
case before using.

STORAGE CAPACITY FOR REFERENCE

HD 
Photos 

SD 
Photos 

1280 x 720 
Video 

(minutes)

320 x 240 
(240p) Video 

(minutes)

160 x 120 
(120p) Video 

(minutes)

Internal Memory 360 600 - 2 7

microSD 
Card

2 GB 9,320 15,530 7 54 170

4 GB 18,640 31,060 14 108 340

8 GB 37,280 62,120 28 216 680

16 GB 74,560 124,240 56 432 1,360

32 GB 149,120 248,480 112 864 2,720

Note: The above amounts are approximations. The actual capacity 
depends on the shooting environment.
The video length limit per file is 30 minutes. File size limit is up to 2 GB.
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GETTING STARTED
When you use the Kidizoom® Action 
Cam HD camera for the first time, switch 
the Master Power Switch to On. Locate 
the Master Power Switch on the bottom 
of the camera and move it to the 1 
position .
When the Master Power Switch is Off, it 
will not be possible to charge the camera 
or play any activities.

BATTERY CHARGING
Note: Adult operation required.
• Make sure the Master Power Switch is turned On before charging.
• Pull up the rubber cover over the Micro-USB Port on the side of 

camera.
• Insert the micro-USB cable (small end) into the Micro-USB Port on 

the camera.
• Insert the large end of the micro-USB cable into a USB port 

on a computer or wall plug. A USB port is usually marked with  
this symbol: 

• Once the connection is successful, you will see the battery  
charging screen.

• When the battery is fully charged, a message will appear on the 
screen briefly, then the screen will turn off. Disconnect the camera 
from the power source.

Note: It will take approximately three hours to fully charge the battery. 
The actual charging time depends on the charging current, the remaining 
charge and the ambient temperature of the charging environment. The 
optimal ambient temperature is 32°F to 104°F (0°C to 40°C).
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BATTERY LIFE
Like with other electronic devices, the more the camera is used, the 
more quickly the battery will drain. Some activities are more demanding 
on the battery, such as capturing photos and video, in which case the 
battery will last approximately 2.5 hours with continuous use. With typical 
usage, the battery will last for approximately one day. The remaining 
battery capacity will display in the right top corner of the screen. When 
the battery level is low, recharge the battery before further use. When 
the battery level is too low, the camera will not turn on until it is charged.

AUTOMATIC SHUT OFF
To preserve battery life, the Kidizoom® Action Cam HD will 
automatically turn off after 2-3 minutes when no buttons are pressed. 
When recording videos or using the time-lapse photos function, the 
camera will not automatically turn off until the process completes. The 
preview screen can also be set to automatically turn off after 30 seconds 
in Settings to help save power. Please refer to the Settings section in  
this manual.

BATTERY MAINTENANCE
Charge the camera regularly to keep it operating at optimal performance, 
even when the camera isn’t in use. Be sure to charge the camera at 
least every six months.

BATTERY NOTICE
Misuse of batteries can lead to them bursting, causing a fire or chemical 
burns. Please follow these precautions:
• Do not disassemble.
• Do not crush and do not expose the battery to any shock or force 

such as hammering, dropping or stepping on it.
• Do not short circuit.
• Do not expose to high temperatures or place near a heat source. Do 

not leave in direct sunlight for any length of time.
• Do not dispose of in fire.
• Do not handle damaged or leaking batteries.
• Keep the battery out of the reach of children.
• Keep the battery dry.
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• Examine the battery charging cord periodically for conditions such as 
damage to the output cord, housing, or other parts that may result in 
the risk of fire, electric shock, or injury to persons. In the event of such 
conditions, the battery charging cord should not be used until properly 
repaired or replaced.

• If you find the time between charges is considerably shortened with 
no change in usage, the battery could be nearing the end of its life. 

MEMORY CARD INSTALLATION
Kidizoom® Action Cam HD is compatible with microSD and 
microSDHC memory cards up to 32 GB.
• Make sure the camera is Off.
• Open the cover over the Memory 

Card Slot on the side of the 
Camera.

• Insert a memory card (not included) 
as illustrated. Once the memory 
card is detected, the memory card 
will automatically be set as the 
default memory.

• To remove the memory card from 
the camera, push the card once 
and it will eject.

Note:
• VTech recommends that you format your memory card before using 

it with the Kidizoom® Action Cam HD camera.
• Data stored on the camera’s internal memory will not be accessible 

while the memory card is in use. Be sure to back up all data to a 
computer regularly to prevent loss of photos and video.
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TO BEGIN USING 
KIDIZOOM® ACTION CAM HD
Make sure the Master Power Switch is in the 1 position  and charge 
the camera before using.
Press the Home (On/Off) button to turn the camera On. When turning 
the camera On for the first time, you will be asked to select the language. 
Press the Left or Right buttons to select your desired language and 
press the OK button to confirm.
Next, you will be asked to set the date and time.
The Left and Right button icons will appear on the item to be adjusted. 
Press the Left or Right buttons to change the value, then press the 
OK button to confirm. Press the Left or Right buttons again to move to 
adjust the other items, or move to the OK icon and press the OK button  
when all values are set.
Note: If the battery level is too low and cannot keep the clock running, 
you will need to enter the time and date again after recharging. If you 
wish to later change the language, date or time, you can do so from the 
Settings menu.

QUICK OPERATION GUIDE
Take Photos
Press the Camera button to go to Camera mode. In Camera mode, 
press the OK button or the Camera button to take a photo. Press the 
Left or Right buttons to cycle through different photo effects or choose 
to take HD photos without effects.

Record Videos
Press the Video button to go to the Video mode. In Video mode, press 
the OK button or the Video button to start or stop the video recording. 
Press the Left or Right buttons to cycle through different video cartoon 
themes or effects. If you are using a memory card, you can also select 
to record HD video.
Note: VTech recommends setting the screen to auto-off when the 
camera is mounted for sports, such as on a bike or skateboard. Please 
refer to the Settings section of this manual to enable the camera screen 
auto-off function.
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Home Menu 
From the Home menu, you can access all of the activities 
on the Kidizoom® Action Cam HD camera. Press the 
Home button to display the Home menu. Then press 
the Left or Right button to select the Activities icon 
and press the OK button to enter.
There are seven activities to choose from:

View Photos and Video
Select the gallery icon on the Home menu and the most recent photo 
or video will be displayed. Press the Left and Right buttons to view 
the previous or next file. Press the OK button to display the File menu, 
select the Play icon to play video, or select the Delete icon  to delete 
the current file and then select the check mark to confirm.
Turning Off the Kidizoom® Action Cam HD Camera
To turn the camera off, press and hold the Home (On/Off) button for two 
seconds. The camera will also automatically turn off after a few minutes 
without input.

CONNECT TO A COMPUTER 
FOR FILE TRANSFER
You can connect the Kidizoom® Action Cam HD camera to a PC or 
Mac computer using the included micro-USB cable. Once the computer 
is connected, you can transfer files between the camera and computer. 
Please follow these steps:
• Open the rubber cover over the Micro-USB Port on the side of the 

camera.
• Insert the micro-USB cable (small end) into the Micro-USB Port on 

the camera.
• Insert the larger end of the micro-USB cable into a USB port on the 

computer. A USB port is usually marked with this symbol: 
• You will see a removable drive called VTech 5202. Please use this 

to transfer files to and from the camera. There is another removable 

1. Camera
2. Video
3. Gallery
4. Time-Lapse

5. Action Videos
6. Games
7. Settings
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drive called VT SYSTEM, which is for the storage of system data 
only. Do not use or remove the VT SYSTEM drive.

Note: Once the camera is connected to your computer, keep it connected  
while files are uploading or downloading. After you finish, safely eject 
Kidizoom® Action Cam HD from your computer and then physically 
disconnect the camera.
To avoid potential damage to your Kidizoom® Action Cam HD, 
ensure the ruber cover over the micro-USB port is firmly closed 
when the camera is not connected to a cable.

To back up photos or videos:
• Open the DCIM folder on the removable drive VTech 5202.
• Drag and drop your photos or videos from their subfolders to a 

location on your computer to back them up.

To transfer photo or video files to 
Kidizoom® Action Cam HD:
• Select the photo or video files you would like to upload from your 

computer first.
• Open the DOWNLOAD folder on the removable drive VTech 5202. 

Drag and drop your photos into the PHOTO folder, and videos into 
the VIDEO folder.

Note: Do not transfer photo or video files created by other cameras onto 
the Kidizoom® Action Cam HD camera, as these file formats may not 
be compatible.

SYSTEM REQUIREMENTS FOR COMPUTER CONNECTION:
Minimum System Requirements
PC Software Requirements:
Microsoft® Windows® 7, Windows® 8 or Windows® 10 Operating System
Macintosh Software Requirements:
Mac OS X 10.9, 10.10, 10.11, macOS 10.12, 10.13 or 10.14
USB Port required
Microsoft® and Windows logos are trademarks of Microsoft Corporation 
in the United States and other countries. Macintosh and Mac logos are 
trademarks of Apple Inc. in the United States and other countries. All 
other trademarks are the property of their respective owners.
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ACTIVITIES

Camera 
Press the Camera button or select the Camera icon from the Home 
menu to enter Camera mode.
Take photos
• Press the Camera button or OK button to take a photo.
• Press the Left and Right buttons to cycle through different photo 

effects or to take HD photos without photo effects.
Self-timer
• Turn the self-timer function on from the Settings menu to set a  

countdown before taking a photo. The self-timer will turn off every 
time the camera is switched off.

Video 
Press the Video button or select the Video icon from the Home menu 
to enter Video mode.
Record video
• Press the Video button or OK button to start recording. Press the 

button once again to stop recording. A Play icon will appear after 
recording completes. Press the OK button to play back your video, 
or press the Right button to select the Delete icon and press the 
OK button to display the Delete menu and delete the video. When 
a video is playing, press the OK or Video button to skip review and 
return to Record mode.

• Press the Left and Right buttons to cycle through video themes and 
effects. If you are using a memory card, you can also select to record 
HD video.

Self-timer
• Turn the self-timer function on from the Settings menu to set a 

countdown before video starts recording. The self-timer will turn off 
when the camera is switched off.

Note: Non-HD video resolution can be changed in Settings. Please 
refer to the Settings section in this manual. When a memory card is 
present, HD video resolution can be selected by pressing the Left and 
Right buttons from the video capture screen.
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Time-Lapse 
Select the Time-Lapse icon from the home menu to take photos at set 
time intervals. 
• Press the Left or Right button to select a time interval, then press the 

OK button to enter the preview screen.
• Press the Camera button or OK button to start recording.
• Press the OK button or Camera button to stop recording, or it will 

stop automatically when the maximum number of time-lapse photos 
is reached, depending on the available memory. 

Gallery 
Select the Gallery icon on the Home menu to view your photos and 
videos.
• The most recent file will appear first. Press the Left and Right 

buttons to select the previous or next file.
• Press the OK button to display the File menu and 

delete the current file or choose to delete all files. 
Use the Left and Right buttons to select the function 
icon, then press the OK button to confirm. Further 
confirmation is necessary to delete files.

• While playing a video, press the Left and Right 
buttons to toggle fast-forward or fast-rewind functions at 1X, 2X, and 
4X speed. Press the OK button to pause or resume playing.

Action Videos 
Select the Action Videos icon from the Home menu to take  
stop-motion, fast-motion, slow-motion or reverse videos. Press the Left 
and Right buttons  to select a mode and press the OK button to confirm.

Stop-Motion Video 
Use this mode to take a sequence of photos and turn those photos into  
stop-motion videos with fun background music.
From the initial Preview screen, select the appropriate function from the 
bottom-left corner:

 Remove the last photo Take a photo

 Finish taking photos and add music
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• After you finish taking photos, your animation will play and you can 
choose background music. Press the Left and Right buttons to 
make a selection or turn off music altogether. Press the OK button to 
make your selection and save the video.

• Once the video is saved, you can view it or you can see it later in 
Gallery mode.

Fast-Motion Video
Record videos that will play at a fast speed. 
• From the Preview screen, press the OK button to start and stop 

recording. The video will take some time to save. When you see 
the Play icon, you can review the video or you can watch it later in 
Gallery mode.

Slow-Motion Video
Record videos that will play at a slow speed. 
• From the Preview screen, press the OK button to start and stop 

recording. The video will take some time to save. When you see 
the Play icon, you can review the video or you can watch it later in 
Gallery mode.

Reverse Video
Record video that will play backwards. 
• From the Preview screen, press the OK button to start and stop 

recording. The video will take some time to save. When you see 
the Play icon, you can review the video or you can watch it later in 
Gallery mode.

Note: 
• Videos created in special recording modes will follow the low video 

resolution setting chosen in Settings.
• You can record up to one minute of fast-motion, slow-motion or 

reverse video per file, though it will be a different length in Gallery 
mode depending on whether it was recorded as fast- or slow-motion 
video.

• Please check that there is enough free memory for this mode, as the 
camera will stop recording if the memory gets too low.
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Games 
There are three built-in games on Kidizoom® Action Cam HD. Select 
the Games icon from the Home menu to enter the Games menu. Press 
the Left and Right buttons to choose a game and press the OK button 
to select it.

1. Sky Rider
Use the OK button to help the paraglider avoid obstacles 
and collect stars.

2. Sea Saver
Move the camera and press OK to remove debris from 
the ocean, but avoid accidentally touching the ocean 
creatures.

3. Skate Challenge
Press the Left and Right buttons to avoid obstacles and 
stay on course.

Settings 
Select the Settings icon from the Home menu to enter Settings.
From the Settings menu, press Left and Right buttons to select an item 
and then press the OK button to adjust it. Once adjusted, press the OK 
button to confirm the new settings, and then press the Home button  
to exit.
You can adjust the following items:
(A) Volume 
 Set the system volume.
(B) Brightness 
 Set the screen’s brightness.
(C) Self-timer 
 Set a timer to delay taking photos or videos.
 Note: The timer will turn off every time the camera is switched off.
(D) Quick review after taking a photo 
 The photo just taken will remain on the screen for a moment after it 

is captured.
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(E) Low Video Resolution 
 160 X 120 (120p): This size allows you to record and save the most 

videos.
 320 X 240 (240p): The video quality is better, but will take up more 

memory so a smaller number of videos can be saved.
 Note:

• HD Video (1280 X 720) is only available when using a memory 
card. This can be selected in Video mode directly.

• Only 320 X 240 (240p) and 160 X 120 (120p) video resolutions 
support themes and effects.

(F) Screen Auto-off 
 Set the screen to turn off to save battery power or for safety in Camera, 

Video, or Time-Lapse modes.
(G) Advanced Settings 
 Press the OK button to enter the advanced Settings menu.
 (i) Memory 
 See the status of the internal memory or memory card. You can also 

choose to format the memory.
 Note: 

• Formatting will erase all data stored in the memory, including all 
saved photos and videos.

• If a memory card is being used, data stored in the internal memory 
cannot be accessed unless the memory card is removed. 

• When the internal memory of Kidizoom® Action Cam HD is getting 
full, or when the file indexes are used up, VTech recommends that 
you back up all of the files from the camera’s internal memory to 
your computer and then delete the files in the camera’s memory to 
free up space.

 (ii) Indoor Light Frequency 
 Set the AC power frequency according to your destination’s region 

when you are traveling. If it is not set correctly, you may see some 
flickering when you are in an indoor environment.

 Note: Please leave your camera set to the default value unless you 
are traveling. For most cases, the frequency of the US is set to 60 
HZ, and Europe is set to 50 Hz. If you still see flickering, please try 
the other setting.
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 (iii) Date & Time 
 Follow the same instructions from initial setup to adjust the date and 

time.
 (iv) Language 
 Change the system language on the camera.
 (v) Parental Controls 
 Disable games or set a daily time limit. By default there is no time 

limit set. You can choose a limit of 15, 30, 60 or 90 minutes per day. 
Once a time limit is reached, games will not be accessible until the 
following day. When games are disabled, icons will appear in the 
Main Menu in a slightly different configuration. 

 Tip: This feature is designed for parents of children who cannot yet 
read, as access to the setting is granted by following simple, on-
screen instructions. 

 Note: 
 The time limit will reset if the date or time settings are changed.
 (vi) Factory Reset 
 Factory Reset will erase content stored in the internal memory and 

reset all system settings to factory defaults. 
 (vii) FCC Compliance Statement 
 This page confirms that this product complies with FCC regulations.

CARE & MAINTENANCE
• Keep the rubber cover of the Micro-USB Port and Memory Card 

Slot tightly closed while the camera is not in use in order to prevent 
dust or water from getting into it.

• Keep the camera clean by wiping it with a slightly damp cloth.
• Keep the camera out of direct sunlight and away from any direct heat 

source.
• Do not drop the camera on a hard surface and do not expose it to 

moisture or immerse it in water.
• Do not use any sharp or pointed objects to prod any parts of the 

waterproof case or the waterproof performance may be affected.
• Keep the Lens clean. If the images are blurry, it could be because 

there is dust or dirt on the Lens.
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WARNING
A very small percentage of the public, due to an existing condition, may 
experience epileptic seizures or momentary loss of consciousness when 
viewing certain types of flashing colors or patterns.
While Kidizoom® Action Cam HD does not contribute to any additional 
risks, we do recommend that parents supervise their children while 
they play games. If your child experiences dizziness, altered vision, 
disorientation, or convulsions, discontinue use immediately and consult 
your doctor. Please note that focusing on the Kidizoom® Action 
Cam HD camera at close range and handling it as a game controller 
for a prolonged period of time may cause fatigue or discomfort. We 
recommend that children take a 15-minute break for every hour of play.

TROUBLESHOOTING
Consult this section if you experience difficulty while operating your 
Kidizoom® Action Cam HD camera. 

Problem Solution

The camera 
isn’t working

1. Turn the Master Power Switch off for  
30 seconds.

2. Turn the Master Power Switch on again and 
then press the Home button to turn it on. It should 
now work properly.

3. If it doesn't work, recharge the battery and  
try again.

Screen 
display is 
abnormal

1. Turn the Master Power Switch off for 30 
seconds.

2. Turn the Master Power Switch on again and 
then press the Home button to turn it on. The 
screen display should be normal again.

Photos and 
videos aren’t 
clear

1. Make sure the lighting conditions of the shooting 
environment are good.

2. Check to see if the Lens is clean.

Recorded 
video is not 
smooth

Check your memory card’s performance. We 
recommend using a microSD / microSDHC card 
Class 10 or above. Using a memory card with lower 
performance may slow the video data writing on the 
card and thus affect the video quality.
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Cannot 
connect to 
computer

• Check the connections on the USB cable between 
the camera and the computer and review the 
connection procedures in this manual.

• Turn the Master Power Switch off for 30 
seconds. Turn the Master Power Switch on and 
connect to the computer again.

Memory 
card can’t be 
detected

• Check if the memory card is correctly inserted.
• Check to see if the memory card is the 

supported type. The camera only supports 
microSD or microSDHC card.

• Check to see if the file system of your memory 
card is FAT or FAT32. The Kidizoom® Action 
Cam HD camera does not support NTFS or exFAT 
file systems. Be sure to back up all important data 
from your memory card and format it in either the 
FAT or FAT32 file system before using in your 
Kidizoom® Action Cam HD.

Can’t view the 
downloaded 
video or photo 
files

Check if the downloaded files are in the correct 
directory on the Kidizoom® Action Cam HD. Photos 
should be put in the DOWNLOAD/PHOTO folder,  
and videos should be put in the DOWNLOAD/VIDEO 
folder.
Kidizoom® Action Cam HD only supports these 
formats:
Photos in Standard Baseline JPEG, and videos in AVI 
(Motion JPEG) created by the Kidizoom® Action 
Cam HD camera.
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TECHNICAL SUPPORT
If you have a problem that cannot be solved by using this manual, we 
encourage you to visit us online or contact our Consumer Services 
Department with any problems and/or suggestions that you might have. 
A support representative will be happy to assist you.
Before requesting support, please be ready to provide the information 
below:
• The name of your product or model number (the model number is 

typically located on the back or bottom of your product).
• A description of the problem you are experiencing.
• The actions you took right before the problem started.
Internet: vtechkids.com/support
Phone: 1-800-521-2010 in the U.S. or 1-877-352-8697 in Canada

KIDIZOOM® ACTION CAM HD 
FREQUENTLY ASKED QUESTIONS
Question 1:
I have purchased a Kidizoom® Action Cam HD, but it will not work 
with my PC. My PC is looking for a driver. I have searched the internet 
and cannot find a VTech® Kidizoom® Action Cam HD driver. What can  
I do?
Answer:
There is no separate driver needed for the Kidizoom® Action Cam HD. 
It uses a standard USB mass storage device driver. Such a driver comes 
standard on all Windows® operating systems such as Windows 7® and 
above, and macOS 10.9 and above. If your computer meets these 
OS requirements and is still looking for a driver, please contact your 
computer’s manufacturer for further assistance. For earlier operating 
systems that do not support mass storage, a system upgrade or mass 
storage device driver may be available. Again, please check with your 
computer’s manufacturer.
Question 2:
What is the ISO value (light sensitivity) of the Kidizoom® Action Cam HD?
Answer:
The Kidizoom® Action Cam HD uses an auto-ISO value. It auto-adjusts 
the exposure time and light sensitivity depending on the environment.
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Question 3:
My Kidizoom® Action Cam HD will not turn on.
Answer:
Please make sure the Master Power Switch is on and the battery is 
charged.
Question 4:
Why are my pictures sometimes grainy and fuzzy? Is there anything I 
can do to improve the picture quality?
Answer:
In a poorly lit environment, the frame rate (shutter speed) drops to allow 
for a longer exposure time. The downside of this is that any movement 
in the frame, or of the hand holding the camera, can result in greater 
blur. Furthermore, the camera sensor will soften the edges in low light 
to counteract the darkness by reducing the image noise. This too can 
sometimes result in a blurred picture. Try to improve the lighting to get 
better results.
Question 5:
Why are the videos grainy and fuzzy when viewed on a computer screen?
Answer:
Please check if the video player of your computer is set to display the 
actual resolution and scale of your videos.
If you use a memory card, you can record 720p HD video. 
Question 6:
Can you delete a group of pictures at once, or do they have to be deleted 
one at a time on the camera?
Answer:
If you connect Kidizoom® Action Cam HD to your computer and access it  
as an external drive, you can select multiple pictures to delete at one time.
Question 7:
If you accidentally delete the pictures by reformatting, is there any way 
to get them back?
Answer:
Unfortunately, if you delete the pictures by formatting the internal storage 
memory, there is no way to retrieve them.
Question 8:
I am trying to transfer my pictures to my computer. I connected per the 
instructions, however no pictures are automatically downloading. Is 
there something I need to do at start-up to get the pictures to download 
and save?



2525
25

Answer:
The picture transfer operation does not start by itself. After you connect 
the camera to your computer and the drive appears ready, you can open 
the drive, look in the DCIM folder, and you should find the images you 
captured with the Kidizoom® Action Cam HD. To transfer images to be 
viewed on Kidizoom® Action Cam HD, move JPEG image files into the 
folder DOWNLOAD/PHOTO.

Microsoft® and Windows logos are trademarks of Microsoft Corporation 
in the United States and other countries. Macintosh and Mac logos are 
trademarks of Apple Inc. in the United States and other countries. All 
other trademarks are the property of their respective owners. 
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KIDIZOOM® ACTION CAM HD 
ACCESSORIES 
Waterproof Case

Case Body

Strap Hook

Camera Button Video Button

Strap Hook

Microphone 
Hole

Buckle Handle

Buckle

Left Button Right Button
OK Button

Angle 
Adjustment 

Handle
Screw Knob

Screw 

Floating Handle

Tripod/Bike Mount 
Screw Hole

Home (On/Off) 
Button
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To Insert the Camera into the Waterproof Case
1. Be sure to inspect the O-ring (refer to the later section for details 

about inspecting the O-ring) and check for water leaks before 
inserting the camera.

2. To avoid water leaking, if you have 
attached a wrist strap to the camera, 
you must detach it before inserting the 
camera into the case.

3. Open the case cover by pulling the buckle handle outwards. After the 
handle is loosened, the buckle can be opened.

 

4. When the waterproof case is open, insert the camera, taking note of 
the position of the buttons. As a point of reference, the Micro-USB 
Port will be on the same side as the buckle on the waterproof case.

 

5. Close the case cover and the buckle to hold the cover in position. 
Push the buckle handle towards the case body to tighten the buckle.
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To Attach the Floating Handle
1. To mount the waterproof 

case onto the Floating 
Handle, align the tripod 
screw hole on the 
waterproof case to the 
screw of the Floating 
Handle. Screw the knob 
on the floating mount 
clockwise to affix the 
camera on the mount.

2. Loosen the angle adjustment handle and you can rotate the angle 
adjustment arm to adjust the capture angle.

3. Tighten the angle adjustment handle after you set the capture angle.
Notes on Use
• This waterproof case is operable up to a water depth of 6' (2 meters) 

for 30 minutes with the camera inserted.
• The waterproof performance is in accordance with the current toy 

safety standards.
• Do not subject this unit to a jet of pressurized water.
• Do not use this unit in hot springs.
• Use this unit in the recommended operation water temperature range 

of 32°F to 104°F (0°C to 40°C). Otherwise, moisture, condensation or 
water leakage may occur and damage the camera.

• Sometimes waterproof performance is lost if this unit is subject to a 
strong impact such as from being dropped.

• Do not throw this unit into the water.
• Do not leave this unit under direct sunlight or in a very hot and 

humid place for a long period of time. If you cannot avoid leaving 
this unit under direct sunlight, be sure to cover it with a towel or other 
protection.

• When the camera overheats, it may automatically turn off or recording 
may malfunction. To use the camera again, leave it in a cool place  
until it returns to room temperature.

• Thoroughly wash off any sunscreen that may get on the waterproof 
case with warm water. 

• After using in salt water, clean the waterproof case in fresh, warm 
water.
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Notes
• When recording underwater, images and videos may appear less 

clear than out of water.
• You can record audio while the camera is under water, but the sound 

level will be reduced.
Inspecting the O-ring
• Carefully check for dirt, sand, hair, dust, salt, threads, etc. on the 

O-ring. If anything is found, wipe it off with a soft cloth.
• Do not leave any cloth fibers on the O-ring after wiping it.
• Check the O-ring for cracks, skewing, distortion, fine splitting, 

scratches, embedded sand, etc. Do not use the case if you find any 
of these conditions.

Maintenance
• Open the Floating Handle to let all the water 

out after use. To open, turn and pull the cap on 
the bottom of the handle.

• Do not use any sharp or pointed objects to 
prod any parts of the waterproof case, or 
otherwise, the waterproof performance may 
be compromised.

• After recording in a location with a sea breeze, remove the case from 
the camera. Wash the waterproof case thoroughly in fresh water 
with the buckle fastened to remove salt and sand, then wipe with a 
soft, dry cloth. Next, submerge the case in fresh water for about 30 
minutes. If the salt is not removed, metal portions of the case may 
rust and cause water leakage.

• Wipe the inside of the waterproof case a soft dry cloth. Do not wash 
it with water.

• Do not use any type of solvent such as alcohol, benzene or thinner 
for cleaning.

• To prevent deterioration of the O-ring, store the waterproof case in a 
cool, well-ventilated location. Do not fasten the buckle.

• Prevent dust from collecting on the O-ring.
• Avoid storing the waterproof case in extreme temperatures, in 

high humidity, or together with naphthalene or camphor, as these 
conditions might damage the case.
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Perform the above maintenance each time you use the waterproof case. 
In the unlikely event that a malfunction of this case causes damage 
due to water leakage, VTech does not guarantee against damage to 
the equipment contained in it (camera, battery, etc.) or the recorded 
contents.

Wide Angle Lens
With the Wide Angle Lens installed on Kidizoom® Action Cam HD, 
you can take photos or videos with a wider view.
To Attach the Wide Angle Lens
1. Align the Wide Angle Lens to the camera Lens 
of the camera.
2. Push it towards the camera Lens and you will 
hear a click.
3. To remove the Wide Angle Lens from the 
camera, just pull it in the opposite direction.
Note: Do not attach the Wide Angle Lens when 
using the waterproof case.
Maintenance
• Keep the lens clean. Otherwise, the captured image will be blurry.
• Do not use any sharp or pointed objects to prod any parts of the 

Wide Angle Lens.
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Camera Holder / Bike Mount / Adhesive Mount

Camera Holder

Bike Mount

Adhesive Mount (Mounting Attachment + Adhesive Flat Mount)

Screw
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QUICK SETUP GUIDE
Getting Kidizoom® Action Cam HD Camera Ready to Mount
Insert your Kidizoom® Action Cam HD camera into the camera  
holder or waterproof case if you would like to attach it to the bike mount 
or adhesive mount.
To insert Kidizoom® Action Cam HD into 
the camera holder, align the camera Lens 
with the big hole of the holder and push 
the camera into it until you hear a click. 

Using the Bike Mount
1. Loosen both adjustment handles by turning 

them counterclockwise. You do not need to 
completely unscrew them.

2. Push the handle as illustrated below. If you 
cannot see the whole screw head, continue to 
turn the handle counterclockwise until you can 
see the whole screw head.

3. Pull out the handle as illustrated. 

4. Attach the Head Tube Clamp onto the 
head tube of the bike.

 Note: For your child’s safety, VTech 
recommends you mount the camera on 
the head tube of the bike instead of the 
handle bar as illustrated:

5. Replace and tighten the adjustment handle by turning it clockwise to 
fix the position of the bike mount.
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6. Mount the holder or waterproof case on the bike mount. Align the 
tripod screw hole on the camera holder or waterproof case to the 
screw of the bike mount. Screw the knob on the bike mount clockwise 
to connect the camera to the mount.

7. The camera is attached on the bike and ready for use. Loosen the 
angle adjustment handle and you can rotate the angle adjustment 
arm to adjust the capture angle.

8. Tighten the angle adjustment handle after you have set the capture 
angle.

Caution: Do not adjust the mount while riding.
Using the Adhesive Mount
1. Attach the adhesive flat mount to the 

mounting attachment as illustrated. You will 
hear a click when the attachment is seated 
correctly.

2. Ensure the surface to which you would like to 
affix the adhesive mount is clean and smooth.

 Note: If there is dirt or liquid on the surface or the surface is rough, 
the adhesive performance will be negatively affected.

3. Remove the protective cover of the adhesive and stick it on a clean, 
flat and smooth surface. 

 Note: If the surface is not very flat or a bit curved, such as that of 
a helmet, add the extra two double-sided adhesive tape strips 
(included) onto the adhesive flat mount to improve the contact area 
between the surface and the adhesive flat mount.

 Remove the protective covers of the adhesive flat mount and the 
extra double-sided adhesive tape strips. Stick the two tape strips 
onto both tips of the adhesive surface of the adhesive flat mount. 
Next, affix the adhesive flat mount to the surface you have chosen.

4. Apply firm pressure to the adhesive flat mount and the contact 
surface and ensure that the surface makes contact over the entire 
area.
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 Note: Maintain this pressure for several minutes to improve the 
adhesive bond strength. 

5. We recommend that the adhesive flat mount stay on the 
surface at room temperature for one day before using to allow 
the ultimate strength to be achieved. At room temperature, 
approximately 50% of the ultimate strength will be achieved 
after 20 minutes, 90% after 24 hours and 100% after 72 hours.

6. Mount the holder / waterproof case onto the adhesive mount. Align 
the tripod screw hole on the camera holder / waterproof case to the 
screw of the adhesive mount. Screw the knob on the adhesive mount 
clockwise to affix the camera to the mount.

7. Loosen the angle adjustment handle and you can rotate the angle 
adjustment arm to adjust the capture angle.

8. Tighten the angle adjustment handle after you set the capture angle.
Note: 
Once the adhesive surface is affixed to a device, do not tear it off or 
the adhesive performance may be reduced and it may not work well in 
subsequent use.
The mounting attachment can be detached from the adhesive mount. 
Push the detachable buckle as shown in the illustration to separate the 
two parts.
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Suggested Configurations for Kidizoom Action Cam HD

Everyday Play

Or +

Bike / Scooter

+ + +

Skateboard
+ + +

Underwater

+ +
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WRIST STRAP ATTACHMENT 
INSTRUCTIONS

1. Locate the thread loop on the end 
of the strap. Insert it into the groove 
behind the bar and then push it 
through.

2. Feed the end of the strap up 
through the loop and pull it all the 
way through.

3. Pull gently to ensure the loop is 
securely tightened around the bar.
Note: The wrist strap can also be attached to the Strap Hook of the 
waterproof case.

Wrist Strap must be removed from the Kidizoom® Action Cam HD 
before putting into the waterproof case to avoid water leaking!
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DISCLAIMER AND LIMITATION 
OF LIABILITY
VTech® Electronics North America, L.L.C. and its suppliers assume 
no responsibility for any damage or loss resulting from the use of this 
handbook. VTech® Electronics North America, L.L.C. and its suppliers 
assume no responsibility for any loss or claims by third parties that may 
arise through the use of this product. VTech® Electronics North America, 
L.L.C. and its suppliers assume no responsibility for any damage or loss 
caused by deletion of data as a result of malfunction, dead battery, or 
repairs.

IMPORTANT NOTE: 
Creating and developing VTech® products is accompanied by a responsibility 
that we at VTech® take very seriously. We make every effort to ensure the 
accuracy of the information which forms the value of our products. However, 
errors sometimes can occur. It is important for you to know that we stand 
behind our products and encourage you to call our Consumer Services 
Department at 1-800-521-2010 in the U.S., or 1-877-352-8697 in Canada 
with any problems and/or suggestions that you might have. A service 
representative will be happy to help you.

NOTE:
This equipment has been tested and found to comply with the limits for 
a Class B digital device, pursuant to Part 15 of the FCC Rules. These 
limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses 
and can radiate radio frequency energy and, if not installed and used 
in accordance with the instructions, may cause harmful interference to 
radio communications. However, there is no guarantee that interference 
will not occur in a particular installation.
If this equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment off and on, 
the user is encouraged to try to correct the interference by one or more 
of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that 

to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.



3838
38

Supplier's Declaration of Conformity
Trade Name: VTech®

Model: 5202
Product name: Kidizoom® Action Cam HD
Responsible Party: VTech Electronics North America, LLC
Address: 1156 W. Shure Drive, Suite 200, 

Arlington Heights, IL 60004
Website: vtechkids.com
THIS DEVICE COMPLIES WITH PART 15 OF THE FCC RULES. 
OPERATION IS SUBJECT TO THE FOLLOWING TWO CONDITIONS: 
(1) THIS DEVICE MAY NOT CAUSE HARMFUL INTERFERENCE, 
AND (2) THIS DEVICE MUST ACCEPT ANY INTERFERENCE 
RECEIVED, INCLUDING INTERFERENCE THAT MAY CAUSE 
UNDESIRED OPERATION.
CAN ICES-3 (B)/NMB-3(B)

To access the above compliance statement from the product software:
1. From the Main Menu, Choose the Settings icon .
2. Go to the Advanced screen , then press the OK button to continue.
3. Choose FCC Compliance Statement  to see the statement.

Caution: Changes or modifications not expressly approved by the party 
responsible for compliance could void the user’s authority to operate the 
equipment.
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